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Abstract

Introduction

Ran GTPase is involved in nucleocytoplasmic shuttling of proteins and is
overexpressed in several cancers. The expression of Ran in malignant melanoma
(MM) and its functional activity have not been described and were investigated in this
study.

Materials and Methods

The prognostic value of Ran expression was tested in a series of 185 primary
cutaneous malignant melanoma (MM) cases using immunohistochemistry (IHC).The
functional activity of Ran was investigated in the two melanoma cell lines. Ran
expression was knocked down using two small interfering RNAs (siRNAs) and the
effect on the expression of the C-Met oncogene, a potential downstream target of Ran,
was tested. Functional effects of Ran knockdown on cell motility and cell proliferation
were also assessed.

Results

Positive Ran expression was seen in 12.4 % of MM and was associated with advanced
clinical stage and greater Breslow thickness. Positive expression was an independent
marker of shorter overall survival (p=0.023). Knockdown of Ran results in decreased
expression of C-Met and the downstream C-met signalling targets ERK1/2. There was
a significant reduction in cell migration (p<0.001) and cell invasion (p<0.001). C-Met
knockdown decreased the expression of Ran through MAPK and PI3K-AKT in A375
cell line, inhibited the cell viability and migration of both A375 and G361 melanoma
cell lines whilst invasion was enhanced.

Conclusion

Ran is a poor prognostic marker in cutaneous malignant melanoma. It up-regulates
expression of the oncogene C-Met and, possibly through this, it promotes cell motility

which may in turn promote metastasis.
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Introduction

Malignant Melanoma (MM) is an aggressive skin cancer and is notorious for its high
metastatic potential (1). Metastatic MM is characterised by high mortality rates and
resistance to chemotherapeutic agents (1-4) . A number of driver genes have been
identified (such as BRAF, KIT, NRAS and NF1) which are associated with the initiation
and progression of MM (5-8). Nevertheless, the precise molecular mechanisms that
drive tumour progression and biological behaviour are unclear.

The Ras superfamily of GTPases controls a remarkable number of diverse cellular
functions including signal transduction, nucleocytoplasmic transportation, microtubule
assemble and nuclear envelope formation (9-12).

Ran GTPase (Ran) is a low-weight (~29kDa) member of the Ras superfamily that
relies on its acidic carboxyl terminus to perform its physiological roles (13). Its principal
function is to regulate the transport of macromolecules, including RNA and proteins,
between nucleus and cytoplasm (14). Ran overexpression has been reported in
several different cancer types, including renal, breast, ovarian, lung and colon (15-18).
Overexpression is seen at both mRNA and protein levels and positively correlates with
aggressive features such as increased cell proliferation, migration and invasion (19).
Recently, we have shown, in lung and breast cancer, that Ran expression may
promote cancer cell survival through up-regulation of the C-Met signalling pathway (20,
21). In these tumours, Ran may be a potential therapeutic target (22, 23).

There is little information on Ran expression and function in MM. Given the importance
of other members of the Ras superfamily (such as NRAS) and associated molecules
(such as BRAF which is a downstream signal transduction target of the KRAS), we
hypothesised that Ran may play a role in the development and progression of MM..
We have shown that silencing Ran expression induces more apoptosis in activated K-
Ras mutant cells compared to their isogenic K-Ras wildtype counterparts (20). We
have also shown that C-MET is mediating resistance to BRAF inhibitors in
BRAFV600E mutant melanoma and established a dominant role for the HGF/MET
axis.(24).Therefore, we hypothesised that Ran may also play a role in the development
and progression of MM.

In the present study, we first investigated the value of Ran protein expression as a
prognostic biomarker. A series of 185 cases of primary cutaneous MM was tested by

immunohistochemistry (IHC) and the significance of Ran expression on overall
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survival as well as lymph node-metastasis-free survival in patients with MM was
evaluated. We next tested the functional activity of Ran in MM, in particular its effect
on expression of the oncogene C-Met protein and its regulation of biological processes
such as cell motility and proliferation.

Materials and Methods

Patient data

Cases were selected from patients consecutively diagnosed with MM between June
2008 and February 2017 at Nottingham University Hospitals, UK, based on the
availability of sufficient melanoma tissue in formalin-fixed paraffin-embedded (FFPE)
blocks for tissue microarray construction. This created a cohort of 228 cases. Further
details on the patient cohort and the tissue microarray construction are given in the
Supplementary Data and Table 1S.

Immunohistochemistry

Immunohistochemistry (IHC) was performed using Ran monoclonal antibody (Abcam,
ab4781) as previously described (25) and full details are given in the supplementary
Data. Sections were scored independently by CF and SE under the microscope using
the H-score method as described previously (26). Briefly, the intensity of Ran
cytoplasmic expression was categorised as 0 (no staining), 1 (weak staining), 2
(moderate staining) or 3 (strong staining). The percentage of melanoma cells in each
category was multiplied by the value of the category resulting in an H-score of 0—-300.
X-tile software version 3.6.1 (Yale University, USA) was used to generate an outcome
dependent cut-off point of RAN H-score as a threshold to dichotomise the tumours into
positive (high expression) and negative (low expression) which happened to be
equivalent to the median H-score.

Cell culture and Ran gene knockdown

Melanoma cell lines A375 and G361 were obtained from the European Collection of
Authenticated Cell Cultures (ECACC) and confirmed by genotyping. Cells were
cultured in DMEM (Life Technologies, UK) supplemented with 10% v/v foetal bovine
serum (Fisher Scientific, UK) and 4mM L-Glutamine (Sigma Aldrich, UK). Expression
of Ran was knocked down using two siRNAs targeted to different parts of the Ran
MRNA. Transfection with siRNA targeted to the non-mammalian gene luciferase was
used as a control. Full details of cell transfection are shown in in supplementary data.

Cell migration and invasion assays



Cell migration and invasion were assessed in transwells with 8um-pore polycarbonate
membranes (Costar) as previously described (20).

Cell invasion was measured in the same way, except that prior to cell seeding the
upper chamber was prepared by coating the filter with 100ul Matrigel at 0.3mg/mL (BD
Biosciences) and the cells attached to the lower surface were fixed, stained and
counted. Further details including wound healing assay is provided in the
supplementary data.

Cell viability assay

A total of 1 X10* cells/100uL was seeded per well of a 96-well culture plate. Twelve
replicates were performed for each cell line and experiments were repeated at least
twice independently. Detailed protocol is provided in supplementary data.

Statistical analysis

Statistical analysis was carried out using GraphPad Prism software for functional
studies and SPSS version 24. Further details are given in the Supplementary Data.
Results

Ran expression in MM by Immunohistochemistry

Twenty cases of MM were evaluated as whole tissue sections in order to evaluate
patterns of staining as a preliminary step to test for the reliability of TMA in assessing
Ran protein expression. Sixty-three cases from the initial cohort of 248 were excluded
due to tissue loss or insufficient melanoma cells for scoring.

Melanoma cells show cytoplasmic staining with occasional membrane accentuation
(Figure 1). Ran staining was semi-quantitatively assessed using the H-score. All cases
were assessed by two observers with a substantial inter-observer agreement (kappa
coefficient = 0.7).

The H-scores ranged from O to 245 with a median H-score of 102. This was the
threshold to dichotomise cases as Ran positive (high expression) (H-score > 102) or
Ran negative (absent or low expression) (H-score < 102). At this cut-off point, a total
of 23/185 (12.4%) of the MM cohort was Ran positive.

The association between Ran expression and standard prognostic parameters
Ran expression had a significant positive association with adverse prognostic
parameters (Table, 2S). A higher proportion of cases with Breslow thickness (BT) >2-
4mm (56.5%) had positive Ran expression while the 1-2 mm BT group had the lowest

rate of expression (13%) (p=0.019). Ran expression also had a significant positive



association with age (p=0.004) where a higher proportion of RAN positive cases were
> 70 years old (p=0.004). No significant association was found with patient’s gender,
melanoma ulceration, melanoma subtype, microsatellites or local recurrence.

Ran expression is an independent marker of poor prognosis in MM
Kaplan-Meier plots and Log Rank tests were used to assess the association of Ran
expression and lymph node metastasis-free survival (LMFS) and overall survival (OS).
Results revealed that Ran negative patients have a statistically significant longer
LMFS (p=0.045) (Figure 2A). Positive Ran expression was also associated with
significant reduction in OS. The mean OS for Ran negative cases was 98.8. SE£3.5
months versus 67.3 SE+9.3 months for Ran positive cases (p=0.001, Figure 2B).
Multivariate Cox proportional hazards model was used to quantify the effect of each
significant prognostic factor, including Ran expression, on overall survival (Table 1).
Data showed that there was a significant increased risk of mortality with male gender
(Hazard Ratio (HR) 3.3, p=0.008), old age (HR 3, p= 0.009), BT 25.01mm (HR 6.7,
<0.001), and ulceration (HR 2.9, 0.003). Positive Ran expression was found to be an
independent prognostic marker and associated with a 1.9-fold increased risk of
mortality (p<0.038).

Ran is aregulator of C-Met/ERK expression in MM cell lines

Western blot and gPCR showed that Ran is expressed in both A375 and G361 cell
lines (Figure 1S). Both siRNAs were able to reduce Ran protein expression although
siRAN2 was slightly more efficient than siRAN1 (Figure 2S). Ran knockdown resulted
in reduction of CMet expression in both cell lines with either siRNAs (Figure 3). Since
ERKZ1/2 is part of the downstream CMet signalling pathway, levels of these proteins
were also tested. Knockdown of Ran expression in both A375 and G361 resulted in
reduction of both total ERK 1/2 and Phospho-ERK1/2 levels (Figure 3).

Knockdown of Ran reduces melanoma cell migration and invasion

Melanoma cell migration was assessed with transwell migration assays. Ran
knockdown with either sSiRAN1 or siRAN2 resulted in significantly reduced cell
migration (p<0.001) for each siRNAs in both cell lines (Figure 4A). In the wound
healing assay, the A375 cell line showed data consistent with the transwell migration
assay, since there was a significant reduction in wound closure following Ran
knockdown, as illustrated in Figure 4C at 24h (siRanl vs siLuc p=0.0003, siRan2 vs
siLuc p<0.0001, Figure 4B).



Following Ran knockdown, invasiveness was also significantly reduced by both
siRNAs in A375 (siRanl vs siLuc P=0.0004, siRan2 vs siLuc P<0.0001) and G361
(siRanl vs siLuc P=0.0073, siRan2 vs siLuc p<0.0001, Figure 4D) cells.

Cell viability was measured 24 hours after transfection, using multiple replicates. There
was possibly a trend for reduced cell viability upon Ran knockdown but this was not
significant (P=0.0512) (Figure 4E and 4F).

C-Met knockdown signalling and functional effects

As shown in Figure 5A and 5B, C-Met was successfully knocked down by using siRNA
in both cell lines during a 72h time course, although in the G361 cell line there was a
return in expression of C-Met at 48h, it was still less expressed than the negative
control group.

Figure 5C and 5D illustrate that phosphorylation of both ERK1/2 and AKT decreased
in either cell line after 48h of C-Met knockdown. At 72h, phosphorylated ERK1/2 was
increased in both cell lines but that of AKT either remained the same in A375 or
increased in G361 cells. Ran expression increases in A375 but not G361 cell lines.
The C-Met knockdown in A375 cell line caused the increase of Ran expression at
24hr, but the expression decreased at 48h and then increased at 72hr. This result is
consistent with the knockdown results that show phosphorylated MAPK and/or
phosphorylated AKT were downregulated at 48hr, but then upregulated at 72hr.
Knockdown of C-Met inhibits the cell viability of both cell lines at 48h (p<0.0001 for
G361 and p=0.0037 for A375) as shown in figure 6A and 6B.

C-Met knockdown after 48h significantly decreased the migration of the A375 cell line
(p=0.0054), but not the G361 cell line (p=0.1456) (Figure 6C). Interestingly, after 72h
of transfection, C-Met knockdown enhanced the invasion of the G361 and A375 cell
lines, although statistical significance was only achieved in the G361 cells (Figure
6D).

Discussion

The list of tumours in which Ran GTPase plays an important role is ever-increasing
and we have previously shown that it is involved in breast and lung cancers (15, 21,
27). Herein we report a potential role for Ran in the development and progression of
malignant melanoma (MM). This study shows that Ran is differentially expressed in
MM tissue from a cohort of 185 patients. Positive expression is seen in 12.4% of
tumours and is significantly associated with features of poor prognosis such as

increased Breslow thickness and age. An association with poor OS (p=0.001) is
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observed and multivariate analysis shows that it is an independent prognostic marker
with a 1.9-fold increase in the risk of death if the tumour shows high Ran expression.
These findings suggest that Ran could be a useful biomarker which would improve
prognostication in MM and, given that there are small molecule inhibitors of Ran, it
could become a potential therapeutic target in melanoma.

The significant association seen between Ran expression and lymph node metastasis-
free survival (p=0.001) prompted us to hypothesise that Ran could be involved in the
metastatic process. We have previously shown that Ran up-regulates the oncogene
C-Met in breast and lung cancer. C-Met is a receptor for motility-inducing Hepatocyte
Growth Factor [24] and thus provides a plausible mechanism for Ran affecting
metastasis through modulation of cell motility. Knockdown of Ran using two different
siRNAs in two different melanoma cell lines resulted in down-regulation of C-Met
expression. This was also associated with down-regulation of both total and
phosphorylated ERK1/2; this is a downstream signalling target of C-met and implies
that Ran-induced changes in C-Met protein result in changes in C-Met function. Since
we have observed that Ran knockdown results in a significant reduction of cell motility
(both cell migration and cell invasion) we can tentatively infer that this may be
mediated through regulation of C-met. Our data contrast with those reported by
Caputo et al. who did not find any effect of Ran on melanoma cell motility (28), although
they did suggest that Ran may have a role in the regulation of C-Met in MM.

By manipulating C-Met expression, through siRNA knockdown, we have observed
inhibition of cell viability and enhancement of cell invasion, as well as decreased
migration for A375.This may be influenced by MAPK and/or AKT temporary
downregulation, as well as Ran late increase at 72h. In dedifferentiated liposarcoma,
C-Met knockdown has been reported to decrease invasion, migration and
tumorigenicity in vitro (29). However, as different methodology and tumour types were
employed in our case, the precise mechanisms of C-Met regulation by Ran remain to
be determined. Ran could control the flux of C-Met RNA directly across the nuclear
membrane or it may regulate C-Met indirectly, by controlling other molecules which
affect C-Met expression levels. In this case, as our data suggest, it is possible that the
functional effects of Ran on cell migration and invasion are mediated through C-Met.
Hence, an assessment of Ran expression may allow stratification of patients into

groups to be treated with either anti-Ran or anti-C-Met therapy.



Whilst our observations on the role of Ran in melanoma are broadly consistent with
our data in other tumour types, one discrepancy is the effect of Ran on cell viability.
We found that Ran knockdown does not appear to influence cell viability in the
melanoma cell lines studied and, whilst this validates our cell migration and invasion
assays, it contradicts results from Caputo et al. in MM and also our own observations
in other tumour types (28). In this particular case, as our data suggests, it is possible
that the functional effects of Ran on cell migration and invasion are mediated through
C-Met.

In summary, to the best of our knowledge, this is the first report showing Ran induces
cell migration and cell invasion in malignant melanoma. This may be effect mediated
through its role as a positive regulator of C-Met expression. Furthermore, this effect is
the first report of Ran as an independent marker of poor prognosis that could also be

used to stratify patients into Ran/C-Met treatment subgroups.



Table 1: Multivariate hazard effect of Ran expression and clinicopathological
parameters on Overall survival.

Factor

Gender

Age

Breslow

thickness

Ulceration

Mitosis

Ran Status

Male
Female
<70
>70
>5.00
25.01
Absent
Present
<4/mm?
>4/mm?
Negative

Positive

Hazard
Ratio

3.334

3.056

6.748

2.924

2.093

1.969

95% Confidence
Interval

1.364-8.149

1.325-7.048

2.993-15.211

1.440-5.934

1.031-4.249

1.040-3.727

p_
value

0.008

0.009

<0.001

0.003

0.041

0.038
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Figure 1: Ran protein expression in malignant melanoma using

immunohistochemistry: A, B, C, and D represent Ran positive melanoma cases (H-
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score >102). E and F Ran negative case (H-score <102). A, C, and E original
magnification X50, B, D and F original magnification X400.

Figure 2: Kaplan-Meier plots for Ran immunohistochemical expression in malignant
melanoma. (A) Lymph node metastasis-free survival and (B) Overall survival.
Figure 3: Western blot for total Ran, Met, ERK1/2, phospho-ERK1/2 and a-tubulin for
A375 and G361 cell lines transfected with 120nM of siLuc, SIRAN1 or SIRANZ2.
Figure 4. Ran knockdown reduces melanoma cell migration in A375 and G361 cell
lines (A) and in A375 measured via wound healing assay as shown in a snapshot of
some of the reduplicate groups (B). Ran knockdown reduces melanoma cell invasion
in both cell lines (C). Bars represent standard deviation of the mean (SDM). ClI: 95%.
* P<0.05, ** P<0.01, ** P<0.001, **** P<0.0001. Technical repeats for each assay=
3. Measurements were taken at 24h of incubation.

Figure 5: Ran knockdown reduces cell proliferation in (A) A375 and (B) G361 cell
lines. RFU: relevant fluorescence units. Bars represent standard deviation of the mean
(SEM).CI: 95%. Technical repeats= 12. ** P<0.001.

Figure 6:
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Figure 4
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Figure 6
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Supplemental Material and methods

Clinicopathological data

Tumours were surgically excised, formalin-fixed and paraffin embedded (FFPE) in
tissue blocks. The main selection criterion was tumours having a Breslow thickness of
>1mm. This selection should allow enough material to assess Ran protein expression
at a substantial amount of invasive melanoma. Patients gave informed consent for
their specimens to be, harvested, stored and used for research. Data and specimens
were anonymised by using only a unique anonymisation code. Ethical approval
(ACP0000174) was gained from the Nottingham Health Science Biobank Access
Committee. A cohort of 228 primary MM cases was used for immunohistochemistry
staining in addition to 20 cases with full-face sections. Patient clinicopathological data
was obtained from the Nottingham University Hospitals patients’ information
databases.

Sixty-three cases from the initial cohort of 248 were excluded due to tissue loss or

insufficient melanoma cells present for scoring.
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In this cohort, there were slightly more males (53%) than females (47%), and most
patients aged 50-70 at diagnosis, with a mean age of 63.5 years. Superficial spreading
malignant melanoma subtype represents 44.9% of all cases. The majority of
melanoma cases had a Breslow thickness of >1-2 mm (38.4 %) with no ulceration
(73.5 %), no microsatellites (97.8%), and mitosis was non-brisk [mitosis <4 per mm2]
(64.7 %). Only 4.3% of cases had local recurrence and 23.3 % developed metastatic
disease (lymph node or distant metastasis), with the mean metastasis-free survival
being 54.4 months (SE£1.9 months). The majority of patients were alive when study
data was collected, with only 13% of cases died due to melanoma. The mean survival
time was 94.8 months (SE+3.4 months).

Tissue microarray (TMA) construction

TMA blocks were constructed using the TMA Grand Master system (3DHistech,
Budapest, Hungary). Target areas were selected on haematoxylin and eosin-stained
sections from representative FFPE blocks for each case. The location of cores to
sample from the tissue block were annotated on scanned images of the sections using
Pannoramic Viewer software (3DHistech). Cores were removed from the FFPE tissue
blocks using the TMA Grand Master (3DHisTech) and arrayed into the recipient
paraffin blocks. Three cores were selected from each target tumour area and a total
of 228 cases were arrayed onto the TMA.

Immunohistochemistry staining and tissue scoring

Tissue sections, 3um thick, were cut from patient specimen FFPE full-face tissue
blocks and TMA blocks. Slides were baked at 60°C for 1 hour to ensure tissue
adherence prior to immunohistochemical staining using UltraView Universal DAB
detection kit (Roche Ventana #05269806001) on BenchMark ULTRA automated
IHC/ISH slide staining system (Roche Ventana) which utilises pre-diluted Liquid
Coverslip (LCS) (Roche Ventana #05424534001) to prevent drying out of tissues
throughout the staining procedure. All steps were performed at 21°C, unless stated
otherwise. Briefly, slides were dewaxed at 72°C for 12 minutes in EZ Prep (Roche
Ventana #05279771001) before antigen retrieval was performed using pre-diluted
Tris-based buffer Cell Conditioning Solution 1 (pH8) (Roche Ventana
#05279801001) for 64 minutes, followed by a wash step using Reaction Buffer
(Roche Ventana #05353955001). Endogenous peroxidase activity was blocked
using 3% H20:2 solution (UltraView Detection kit). Rabbit Anti-Ran polyclonal
antibody (Abcam, ab4781) diluted in Antibody Diluent (Roche Ventana number 251-
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018) at 1:100 was then applied to each slide and incubated for 32 minutes, followed
by another wash step. Slides were then incubated with a Horseradish Peroxidase
multimer (UltraView Detection kit) for 8 minutes, for signal amplification, followed by
another wash step. The DAB chromogen (0.2%) and peroxidase enzyme (0.04%
H20:2 in PBS) from the UltraView Detection kit, were then mixed, applied to the slides
and incubated for 8 minutes, followed by another wash step. The slides were then
incubated with copper sulphate (5g/L) (UltraView Detection kit) for 4 minutes, for
stain enhancement, followed by another wash step. Sections were then
counterstained with Haematoxylin 1l (Roche Ventana #05277965001) for 12 minutes.
Slides were rinsed with EZ Prep to remove residual LCS, dehydrated with IMS,
cleared with xylene, and permanently mounted in pertex under a glass coverslip.
Breast carcinoma tissue has been used as a positive control. Slides were scanned
on the Nanozoomer C9600-01 (NanoZoomer; Hamamatsu Photonics, Welwyn
Garden City, UK) and images were edited/annotated using NDP.view 2 software
version 2.6.13. Scoring was done using the H-score method.

Statistical analysis

Data sets were statistically compared and analysed by two-way factorial ANOVA and
post-hoc (Sidak). The ImageJ software (NIH, USA) was used to quantify the wound
healing assay results as follows: File > Open Image, Image > Type > 8-bit then
Adjust > Threshold >reset, Process > FFT > Bandpass filter > OK, Image > Adjust >
Threshold > set, Process > Filters > Minimum > Set Radius at 7.0, Wand tool >
select wound healing surface area, Analyse > Measure. IBM SPSS software version
23 (Chicago, IL, USA) was used to analyse the relation between Ran protein
expression in relation to clinicopathological parameters and survival. Kappa
coefficient (k) test was used to measure inter-observer agreement. The association
of Ran expression with clinicopathological parameters was assessed using the chi-
squared test or Fisher's Exact Test. Ran expression with metastasis-free survival
and overall survival was assessed using the Kaplan-Meier Log Rank test. Cox
hazard regression analysis was performed to quantify the risk of clinicopathological
parameters and Ran expression on survival. A P-value of <0.05 (two-tailed) was
considered to denote statistical significance.

Multiple clinicopathological parameters are associated with lymph node

metastasis-free survival and overall survival in this cohort of patients.
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Kaplan-Meier Log Rank tests were used to assess the relation of clinicopathological
parameters with lymph node metastasis-free survival and overall survival in this cohort
of patient’s Supplementary table 2. Lymph node metastasis-free survival was defined
as the duration (in months) from the date of primary melanoma diagnosis to the date
of lymph node metastasis, while overall survival was defined as the duration (in
months) from the date of primary MM to the date of death caused by melanoma. As
expected, Breslow thickness was a significant prognostic factor, being highly
significantly associated with overall survival (p<0.001) and significantly associated
with lymph node metastasis free survival (p=0.038). Gender (p=0.006), age (p<0.001),
ulceration (p<0.001) and mitosis (p=0.012) were also significantly associated with
overall survival. Whereas microsatellites was not significantly associated (p>0.05).
Supplementary Table 1S: Summary of the clinicopathological data for

melanoma patients

Male 98 (53)
Female 87 (47)
Age at primary <50 36 (19.5)
diagnosis (years) 50-70 83 (44.9)
>70 66 (35,7)
Histological Subtype© LUl qle) ¢! 53 (28.6)
SSMM 83 (44.9)
NM 30 (16.3)
ALM 8 (4.3)
LMM 11 (5.9)
Breslow 1 H G T2>1-2 71 (38.4)
(mm) T3>2-4 65 (35,1)
T4>4 49 (26,5)
Clinical Stage IA 2 (1.1)
IB 62 (33.5)
A 38 (20.5)
1B 28 (15.1)
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Microsatellites

Local Recurrence

Lymph

Metastasis

Distant Metastasis

Mortality

lc
0l
e
v

Absent
Present
Absent
Present

Absent

Non-brisk (<4/mm2)

Brisk (>4/mm?)

Absent

Present

(\'[o]s [} Absent

Present

Absent

Present

Alive

Death due to melanoma
other 34 (18.4)

Death due

causes

to

20 (10.8)
2 (1.1)

9 (4.9)

24 (13.0)
136 (73.5)
49 (26,5)
180 (97,8)
4(2.2)

10 (5.4)
119 (64.7)

55 (29.9)

177 (95.7)
8 (4.3)
170 (91.9)
15 (8.1)

157 (84,9)
28 (15.1)
127 (68.6)
34 (13)

© Main Histological subtypes are SSMM: superficial spreading malignant melanoma.

NM: Nodular melanoma. ALM: Acral lentiginous melanoma. LMM: Lentigo maligna

melanoma.

Supplementary Table 2S: Association of Ran expression with

clinicopathological parameters in malignant melanoma cases.
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0.506%**
08 84 (51.9) 14 (60.9)

87 78 (48.1) 9 (39.1)

185 0.004*
71 30 (18.5) 63 (26.1)

65 80 (49.4) 3 (13.0)

49 52 (32.1) 14 (60,9)

185 0.323*
83 75 (46.3) 8 (34.8)

30 27 (16.7) 3 (13)

8 6 (3.7) 2 (8.7)

11 11 (6.8) 0 (0)

53 43 (26.5) 10 (43.5)

197 0.019%**
71 68 (42.0) 3 (13.0)

65 52 (32.1) 13 (56.5)

49 42 (25,9) 7 (30.4)

185 0.351*
2 2 (1.2) 0 (0)

62 59 (36.4) 3 (13)

38 33 (20.4) 5 (21.7)

28 22 (13.6) 6 (26.1

20 16 (9.9) 4 (17.4)

2 2(1.2) 0 (0)

9 7 (4.3) 2 (8.7)
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_ 27 21 (13%) 8 (13%)
_ 136 122 (75.3 %) 40 (60.9 %)
_ 49 14 (24.7 %) 9 (39.1 %)
_ 180 157 (97.5 %) 4 (100.0 %)
_ 4 4 (2.5 %) 0 (0%)
_ 10 10 (6.2 %) 0 (0.0%)
_ 119 188 (66.7 %) 11 (50.0 %)
_ 55 44 (27.2%) 11 (50.0 %)
_ 177 154 (95.1 %) 23 (100.0%)
_ 8 8 (4.9 %) 0 (0.0%)

* Chi-squared test, ** Chi-squared test for trend, *** Fisher’s exact test
Cell culture

Melanoma cell lines, A375 and G361 (ECACC) derived from patients (Life
Technologies, 41965-039) were cultured in DMEM supplemented with 10% (m/v)
foetal bovine serum. When cells were near confluence, the media were aspirated off
and cells were gently washed with PBS and incubated in 5% CO2 at 37°C with
Trypsin/EDTA solution for 5 minutes. Following incubation, fresh media were added
and cells were transferred in sterile universal tubes and centrifuged at 300 x g for 5
minutes. Supernatants were aspirated off and cell pellets were re-suspended in new
media. Fresh media were then added to sterile T75 flasks before adding proportions
of re-suspended cells. An automated cell counter was used to count cells. Differ Small
interfering RNA transfection.

Small interfering RNA transfection
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The two independent RAN siRNAs (siRAN1 Sense  GUUUGAUGUAACAU
CGAGAUU-3’ ; Antisense 5 -AAUCUCGAUGUUACAUCAAAC-3’ ; siRAN2 Sense 5’
CACCAACAGAGGACCUAUUAA-3;Antisense5’-UUAAUAGGUCCUCUGUUGGUG-
3’) and the control siRNA (siLuc) were purchased from Eurofins Genomics. Cells were
seeded (3x 105 cells/ well) on 6-well culture dishes and were allowed to grow to
approximately 70% confluence. On the day of transfection, normal DMEM were
removed and 2 ml of reduced serum medium (Opti-MEM, Life Technologies, 31985-
047) were added to each well. The wells were incubated in 5% CO2 at 37°C for 60
minutes. Meanwhile, the transfection complexes were prepared. In separate
Eppendorf tubes, 100pMof each RAN siRNA (siRAN1, siRAN2 and siLuc) were diluted
in 250ul of Opti-MEM. For each of the siRNAs, 5ul of Lipofectamine 2000 reagent
(Invitrogen, 11668-19) were diluted in 250ul of Opti-MEMin separate tubes. The
solutions were incubated briefly for 5 minutes at room temperature. Then, each siRNA
solution was gently mixed with Lipofectamine and the complexes were incubated for
an additional 20 minutes at room temperature. Transfection complexes were added to
each well and incubated for 6 hours. Opti-MEM were removed and replaced with
DMEM after the incubation period. Cells were harvested 24 hours and 48 hours post-
transfection for functional assays and protein extractions respectively. Results were
compared against cells transfected with a siRNA that targeted the luciferase gene
(control). Differentiation between live and dead cells was determined based on trypan
blue.

Using two separate Ran siRNAs at different concentrations, Ran knockdown was
confirmed with WB and densitometry (Sup. Fig. 2) analyses. In A375 cells, 40 nM, 80
nM and 120 nM of siRan1l resulted in 83%, 85% and 94% knockdown efficiencies and
the same concentrations of siRan2 gave efficiencies of 86%, 84% and 90%
respectively. In G361 cells, knockdown efficiencies were approximately 76%, 78% and
80% for siRanl and 78%, 79% and 85% for siRan2. To evaluate the functional
relevance of both Ran siRNAs, results from Ran siRNA-transfected cells were
normalised against those from luciferase siRNA-transfected cells.

Gradient and real-time polymerase chain reaction

Total RNA was extracted from cells using the GenEluteMiniprep Kit (Sigma-Aldrich,
RTN70-1KT) and DNase treatment was performed using the on-column DNase
Digestion Set (Sigma-Aldrich, DNASE70-1SET) according to the manufacturer’s

instructions. Extracted RNA was quantified using NanoDrop2000 (Thermo Fisher
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Scientific). Before reverse transcription, a master mix was prepared for each reaction
(2.5ul of random hexamers were added to 2ug of total RNA and made up to a total
volume of 15ul with dH20) and incubated at 70°C for 5 minutes and then on ice for 5
minutes. To every master mix, 5ul of 5x buffer, 1.25ul of ANTPs, 1ul of M-MLV enzyme,
0.625ul of RNAse inhibitor (all Promega, UK) and 2.125ul of dH20were added (final
volume 25l ). The reactions were incubated at 37°C for 60 minutes and 95°C for 10
minutes.

Primers for the RAN gene (Forward 5-GCACGACTTAGAGGTTGCTCA-3’; Reverse
5-GCTTCATTCTCACAGGTCATCAT-3') were designed using OligoAnalyzer
software (Integrated DNA Technologies). Additionally, pre-designed primers were
purchased (Eurofins). Ribosomal protein S23 (RPS23) was used as an internal control
(Forward 5-TAGTCACCGACGAGACCAGA-3’; Reverse 5-TCAACTCCTAC
TTTTTCCAGCAC-3’). Gradient PCR was performed for primer annealing temperature
optimisation. Then, the gradient PCR product was analysed upon LightScanner (Idaho
Technology, Inc.) using high resolution melting. Real-time PCR was performed using
GoTagMastermix (Promega, UK, A600A). Reactions were analysed upon Stratagene
Mx3005P using the following cycle conditions: 50°C for 10 minutes,95°C for 2 minutes,
followed by 40 cycles at 95°C for 30 seconds and 60°C for 1 minute. The results from
gPCR were normalised against RPS23 expression using the AACt method.

Western blot analysis

Cells were lysed in lysis buffer (Thermo Fisher Scientific, 87787) containing a protease
inhibitor cocktail (Thermo Fisher Scientific, 1861281) for 15 minutes at 4°C with
constant agitation. Protein amounts were quantified using the BCA assay kit (Thermo
Fisher Scientific, 23225).The respective protein amounts were separated using SDS-
PAGE 4-12% NuPAGE Gels (Thermo Fisher Scientific, NP0335BOX) and transferred
to PVDF membrane (GE Healthcare, 10600023). The proteins of interest were
detected with specific primary antibodies: Rabbit Ran (diluted 1:1000, Millipore,07-
517) and mouse a-tubulin (diluted 1:2000, Abcam, DM1A). Further, Rabbit Met mADb
(diluted 1:1000, D1C2), Rabbit Phospho-Met mAb (diluted 1:1000, D26), Rabbit
ERK1/2 mAb (diluted 1:1000, 137F5) and Rabbit Phospho-ERK1/2 mAb (diluted
1:2000, D13.14.4E) were used (all purchased from Cell Signalling). After three further
washes, detection was performed using the Enhanced Chemiluminescence Kit
(Pierce, Thermo Fisher, UK). Bands were visualised using C-digit scanner (Li-Cor) and

guantified by densitometry using Studio Lite (Li-Cor).
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PrestoBlue cell viability assay

The seeding densities of cell lines were first optimised. Cells (105cells/well) were
seeded on 96-well culture dishes and incubated overnight to allow cells to adhere.
The following day PrestoBlue (Life Technologies, A13261) was diluted 1:10 in culture
media and incubated at room temperature for 10 minutes. The media were removed
from the wells and replaced with aliquots of 100ulPrestoBlue solution and the plates
were incubated for 60 minutes at 37°C. Plates were analysed upon FlexStation Il
(Molecular  Devices, USA) and fluorescence values were obtained
(Excitation/Emission: 540nm/610nm, bottom reads). Sterile DMEM were used as
negative controls.

Transwell migration and invasion assay

Approximately 10* cells in serum-free conditions were seeded into the top of each
transwell (Corning, 3422) with or without Matrigel Matrix coating (Corning, 356230) for
invasion or migration assays respectively. The cells were allowed to migrate or invade
towards the bottom of the transwell with 10% FBS as a chemoattractant for 24 hours
incubated as normal. Then, all the transwells were moved to empty wells where trypsin
was added to harvest the cells that migrated/invaded the bottom of the transwell. The
trypsinised media were then transferred to the previous wells as appropriate and 1 ml
of DMEM was added to every well to ensure trypsinisation had stopped. Cells were
stained with Calcein AM (eBioscience, 65-0853-39) and incubated as normal for 30
minutes. Receiver wells with no chemoattractant were used as controls. Assays were
performed in triplicate and on at least two separate occasions.

After 24h of transfection with the siRNA, the cells were digest with trypsin, washed
and counted. Five x104 cells were seeded in serum-free DMEM in the top chamber
and allowed to migrate towards the lower chamber containing 10% v/v FBS as a
chemoattractant (complete growth medium). After 24 hours, migration was assessed
as follows: transwells were moved to empty wells where trypsin was added to harvest
the cells that were present on the underside of the membrane. The trypsinised cells
and media were then transferred to the original wells and 1 ml of complete growth
medium DMEM was added to every well to ensure that trypsinisation had stopped.
Viable cells were stained by incubating with 2uM Calcein AM (eBioscience) for 30
minutes and then counted. Receiver wells with no chemoattractant were used as
controls. Migration percent was defined as the mean count of cells migrated with

chemoattractant divided by the mean count of cells seeded x100.
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Wound healing assay

Wound healing assays were performed in 24-well culture dishes. Culture inserts (Ibidi,
80209) were firmly attached to each well and 0.5 X105 cells were added into each
well. The plates were incubated overnight and checked to confirm confluence, the
inserts were removed, cells were washed with sterile PBS and then DMEM containing
10% FBS was added. Cells were imaged at 0 and 24 hours using Nikon Eclipse Ti2
microscope. Results were analysed using the ImageJ software (NIH, USA).

Cell viability assay

A resazurin-reduction assay was performed by diluting PrestoBlue (Life Technologies,
A13261) at 10% in complete cell growth medium (DMEM, 10%FBS, 4mM L-
Glutamine). The plates were incubated for 60 minutes at 370C and then bottom-read
at 540nm Excitation /610nm Emission filters on the FlexStation Il (Molecular Devices)
fluorescence plate reader. The fluorescence values of blank wells were subtracted

from the raw values before normalisation to the first time point.
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Sup Figure 2

Supplementary Figure Legend

Supplementary Figure 1: Ran expression on transcriptional (mRNA) and post-
transcriptional (protein) levels in malignant melanoma (A375, G361) and colorectal
cancer (SW620) cell lines. A: Western blot for Ran and a-tubulin (control) and
densitometry analysis. B: qPCR for Ran expression normalised against RPS23
(control) expression. Reactions in gPCR were performed in triplicates.
Supplementary Figure 2: Optimisation of Ran siRNA concentrations with the

respective densitometry analyses.
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